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Summary 

The purification of a functional soluble protein from biological or in vitro expression systems 

can be problematic, the enrichment of a functional membrane protein for biochemical 

analyses can be a serious technical challenge. Recently, we have been characterising plant 

endomembrane nucleotide sugar transporters using a yeast expression system. However 

rather than enriching these in vitro expressed proteins to homogeneity, we have been 

conducting biochemical characterization of these transport proteins in yeast microsomal 

fractions. While this approach has enabled us to estimate a variety of kinetic parameters, the 

accurate determination of turnover number of an enzyme-substrate complex (kcat) requires 

that the catalytic site concentration (amount of protein) in the total reaction volume is known. 

As a result, we have been employing targeted proteomics (multiple reaction monitoring) with 

peptide standards and a triple quadrupole mass spectrometer to estimate the absolute amount 

of protein in a mixed protein microsomal fraction. The following method details the steps 

required to define the absolute quantitation of an in vitro expressed membrane protein to 

define complete kinetic parameters. 
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1. Introduction 

 

The development of the Michaelis–Menten model over 100 years ago [1,2], in which the rate 

of the enzyme is related to the substrate concentration, now represents one of the most widely 

used equations for the examination of enzyme kinetics. While the original derivation of the 

equation was based on a number of assumptions, some of which were subsequently addressed 

[3], the equation is still incredibly useful in understanding an enzymes function as it provides 

a kinetic description of its activity. Significantly, both the Michaelis constant (Km) providing 

a measure of substrate affinity and the maximal rate or maximum velocity of the enzyme 

(Vmax) can be empirically derived by measuring catalytic rates at various substrate 

concentrations. However, while the determination of both Km and Vmax do not require any 

knowledge of the enzyme concentration, this information is necessary to derive the turnover 

number (kcat) of the enzyme. In general, the turnover number (kcat) and specificity constant 

(kcat/Km) are now regarded as the principal steady state kinetic parameters necessary to 

adequately describe an enzyme [4]. 

 

The determination of an enzymes kinetic parameters is commonly accomplished after the 

enrichment and purification of the enzyme to near homogeneity. This enrichment process was 

traditionally accomplished directly from complex biological material [5], but is now more 

commonly achieved after in vitro expression in a heterologous system such as Escherichia 

coli [6]. However, the purification and enrichment of membrane proteins to near 

homogeneity using the above approaches can be extremely challenging. While there are 

documented successes using such approaches with membrane proteins [7], these likely hide 

the numerous failures. We recently faced similar problems when attempting to biochemically 

characterize members of the Nucleotide Sugar Transporter family from Arabidopsis [8,9]. 

Although we had developed a sensitive assay [10] using microsomal fractions from 

Saccharomyces cerevisiae (yeast) expressing our transporters of interest, the nature of these 

membrane proteins (8 to 10 predicted transmembrane domains), incentivised us to develop an 

alternative approach over further enrichment and purification. The determination of both Km 

and Vmax was possible, however an estimation on the amount of protein in this mixed 

microsomal fraction was required to determine kcat. As a result, we developed an MRM-based 

assay for the absolute quantitation of our expressed transporter in yeast microsomal 

preparations using protein specific synthetic peptides and triple quadrupole mass 
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spectrometry. This approach has now been successfully applied on numerous occasions [8,9] 

to determine the concentration of a protein and to determine complete kinetic parameters. The 

method details the in vitro expression of a membrane protein in yeast, the enrichment of a 

mixed membrane lysate contacting the membrane protein of interest and the absolute 

quantitation of the expressed protein by triple quadrupole mass spectrometry (MRM) and 

peptide standards for the estimation of kcat. 

 

The accurate characterisation of enzymes will be a vital aspect in our capacity to develop 

next generation agricultural crops. Future bioengineering programs will rely on large-scale 

systems biology approaches to develop models that predict engineered outcomes and thus the 

accuracy of these models will directly rely on the quality of data and the contributions of 

well-characterized parts [11,12]. 
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2. Materials 

Prepare solutions using ultrapure water (18 MΩ cm at 25°C) and analytical grade reagents. 

Utilize LC-MS grade reagents for solutions and buffers used in conjunction with mass 

spectrometry. Prepare all reagents at room temperature, unless otherwise indicated, reagents 

can be stored for several months and room temperature.  

 

2.1. In vitro expression in Saccharomyces cerevisiae 

1. Saccharomyces cerevisiae (yeast) strain INVSc1 (see Note 1). 

2. Yeast inducible expression vector, such as pYES-DEST52 (see Note 2). 

3. Yeast transformation kit, such as, S.c. EasyComp Transformation Kit (Thermo Fisher 

Scientific) (see Note 3). 

4. Agar 

5. Yeast Nitrogen Base without amino acids (see Note 4). 

6. Yeast Synthetic Drop-out Medium, lacking the appropriate selectable marker, such as 

uracil (see Note 5). 

7. 50 mL tubes. 

8. 250 mL baffled flask (see Note 6). 

9. Bench top centrifuge with rotor for 50 mL tubes capable of 3,000 x g. 

10. 1000 mL baffled flask (see Note 6). 

11. Preparative centrifuge for 250 mL tubes and capable of 3,000 x g. 

12. 20 % dextrose (filter sterilized). 

13. 20 % galactose (filter sterilized) (see Note 7). 

14. 1 M sodium azide solution (see Note 8). 

 

2.2. Isolation of yeast microsomes 

1. Yeast Resuspension Buffer: 50 mM potassium phosphate, pH 7.1, 1.4 M sorbitol, 10 

mM NaN3 and 40 mM 2-mercaptoethanol. 

2. Lyticase from Arthrobacter luteus. 

3. Yeast Lysis Buffer: 0.8 M sorbitol, 10 mM triethanolamine / acetic acid pH 7.2, 1 

mM EDTA 

4. Protease inhibitors, such as, SigmaFAST™ Protease Inhibitor Cocktail Tablet 

(Sigma-Aldrich) 

5. 100 mM phenylmethanesulfonyl fluoride (PMSF) 
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6. Microsome Resuspension Buffer: 10 mM N-(2-Hydroxy-1,1-

bis(hydroxymethyl)ethyl)glycine (Tricine-KOH) pH 7.5, 50 mM potassium D-

gluconate, 20 % glycerol (see Note 9). 

7. Bench top centrifuge with rotor for 15 mL and 50 mL tubes capable of up to 8,000 x 

g. 

8. Ultracentrifuge with rotor for 30 mL tubes and capable of 100,000 × g for pelleting 

microsomes. 

9. glass beads acid-washed 

10. Colorimetric protein quantification assay. 

 

2.3. Analysis of microsomes by immunoblotting 

1. Mini electrophoresis chamber for protein separation. 

2. Sodium dodecyl sulfate polyacrylamide gel electrophoresis (SDS-PAGE) precast gels 

compatible with the electrophoresis chamber (see Note 10). 

3. Electrophoresis Buffer: 248 mM Tris-base, 1.92 M glycine, 1 % (w/v) SDS. 

4. Sample Buffer: 40 mM Tris-HCl (pH 6.8), 5 % (w/v) SDS, 0.4 % (w/v) bromophenol 

blue, 1 % (v/v) 2-mercaptoethanol, 1 X protease inhibitor, 5 mM PMSF, 8 M urea, 0.1 

mM EDTA. 

5. 2-mercaptoethanol solution. 

6. SDS-PAGE protein markers. 

7. Immunoblot apparatus. 

8. Western Transfer Buffer: 25 mM Tris-base, 192 mM glycine, 10 % (v/v) methanol. 

9. 100 % (v/v) methanol. 

10. Filter paper for immunoblotting. 

11. Nitrocellulose membrane. 

12. TBST Buffer: 50 mM Tris-HCl (pH 7.6), 150 mM NaCl and 0.1 % (v/v) Tween-20. 

13. Skim milk powder. 

14. Protein tag antibody, such as, Anti-V5 antibody (Invitrogen) (see Note 11). 

15. Secondary antibody, Anti-Mouse- or Anti-Rabbit- IgG Peroxidase (see Note 12). 

16. Chemiluminescent substrates for horseradish peroxidase. 

17. Chemiluminescent imaging system. 

 

2.4.  Determination of peptides for MRM quantitation 
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1. Tandem mass spectrometer (MS/MS) with liquid chromatography (LC) delivery 

system capable of data dependent acquisition (DDA) / independent data acquisition 

(IDA) (see Note 13). 

2. Reverse phase column for peptide separation, such as a C18 HPLC column. 

3. Digestion Buffer: 1 M urea and 10 mM tris(hydroxymethyl)aminomethane (Tris-

HCl), pH 8.5 solution (see Note 14). 

4. 1 M dithiothreitol (DTT) (see Note 15). 

5. 1 M iodoacetamide (IAA). (see Note 16). 

6. Sequencing grade trypsin. 

7. Solid phase extraction (SPE) for peptides, such as Micro SpinColumns with C18 

(Harvard Apparatus, MA, USA). 

8. SPE Buffer 1: 80% acetonitrile (v/v) with 0.1% trifluoroacetic acid (v/v). 

9. SPE Buffer 2: 2% acetonitrile (v/v) with 0.1% trifluoroacetic acid (v/v). 

10. MS Buffer A: 2 % acetonitrile, 0.1 % formic acid. 

11. SpeedVac concentrator. 

12. Access to search engine to identify proteins from data generated by tandem mass 

spectrometry (see Note 17). 

 

2.5. Quantitation of induced membrane protein by MRM 

1. Triple quadrupole mass spectrometry (MS) system coupled to a liquid 

chromatography (LC) delivery system capable of MRM mode (see Note 13). 

2. Synthetic peptide standards > 95 % purity (see Note 18). 

3. Infusion Buffer: 50 % acetonitrile and 0.1 % formic acid 

4. Syringe pump 

5. Gastight Hamilton syringe 500 µL 

6. MS Buffer A: 2 % acetonitrile, 0.1 % formic acid. 

7. Reverse phase column for peptide separation, such as a C18 HPLC column. 

8. Software for MRM method development, profiling and quantitation, such as Skyline 

(https://skyline.gs.washington.edu/labkey/project/home/software/Skyline/begin.view) 

(see Note 19). 
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3. Methods 

3.1. Yeast transformation and protein induction 

1. Transform the expression vector containing the sequence encoding your gene of 

interest (see Note 20) into Saccharomyces cerevisiae (yeast) using a commercial yeast 

transformation kit (see Note 21). 

2. Make dropout media using Yeast Synthetic Drop-out Medium and Yeast Nitrogen 

Base according to the product description. For plates add agar (20 g / L). After 

autoclaving, add dextrose to a final concentration of 2 %. 

3. Plate transformed yeast onto agar plates and incubate for 3 to 4 days at 30 °C. 

4. Pick a colony and inoculate a 50 mL starter culture (dropout media, see Note 5) in a 

250 mL flask. 

5. Incubate with shaking for approximately 24 hours at 30 °C. 

6. Transfer culture to a 50 mL tube and centrifuge at 2,500 x g for 5 min at room 

temperature. 

7. Take yeast pellet and inoculate 200 mL of dropout media, replacing the 2 % (w/v) 

dextrose with 2 % (w/v) galactose, in a 1000 mL flask (see Note 22). 

8. Incubate with shaking overnight at 30 °C (see Note 23). 

9. Harvest yeast cells from the induced culture by centrifugation at 2,500 x g for 5 min 

at room temperature. 

10. Wash the pellet with 30 mL of 10 mM sodium azide (see Note 8) and repeat 

centrifugation. 

11. Decant supernatant and freeze pellet at -80 °C. 

 

3.2. Enrichment of microsomes from yeast cultures 

1. Weigh the yeast pellet to estimate the amount of cells (fresh weight), should be 

around 2.5 g. 

2. Resuspend the yeast pellet in 10 mL of Yeast Resuspension Buffer. 

3. Add the appropriate amount of Lyticase to the yeast solution (see Note 24). 

4. Incubate at 37 °C for 1 h to generate spheroplasts (see Note 25). 

5. Harvest spheroplasts by centrifugation at 2,500 x g for 5 min. 

6. Wash the spheroplasts pellet with Yeast Lysis Buffer. 

7. Resuspend the washed spheroplasts in 5 mL Yeast Lysis Buffer containing protease 

inhibitor cocktail and 1 mM PMSF. 
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8. Add 5 ml acid-washed glass beads and disrupt spheroplasts by vortexing for 1 min, 

place on ice for 1 min, repeat twice. 

9. Centrifuge spheroplast lysate at 3,000 x g for 5 min, keep supernatant on ice. 

10. Resuspend the un-ruptured spheroplast pellet in 5 mL Yeast Lysis Buffer containing 

protease inhibitor cocktail and 1 mM PMSF and repeat the vortexing step. 

11. Collect supernatant by centrifuging at 3,000 x g for 5 min; repeat this step two more 

times to produce a 20 mL lysate. 

12. A microsomal fraction is obtained by sequential centrifugation. 

13. Centrifuge the 20 mL lysate at 8,000 x g for 10 min and take supernatant. 

14. Centrifuge the supernatant at 100,000 x g for 75 min and discard supernatant. 

15. Resuspend the microsomal pellet in Microsome Resuspension Buffer (see Note 9). 

16. Estimate the protein concentration in the microsomal fraction using a protein 

quantification assay and then store fractions at -80°C. 

 

3.3. Assessment of protein induction by immunoblotting 

1. To ensure the protein has been induced and is present in the microsomal fraction, 

immunoblotting can be undertaken using a protein specific antibody or with an 

antibody against a tag, such as the V5-tag or His-tag (Fig. 1A). 

2. If using a mini-gel system, around 2 µg (~0.5 µL) of protein is suitable. Add Sample 

Buffer (~5 µL) then incubate at 65°C for 15 min. 

3. Load samples and protein standards onto a preassembled precast gel (see Note 26). 

4. Separate the protein samples on the gel at 200 V for 45 to 60 min or until the dye 

front reaches the bottom of the gel. 

5. Remove the gel from the plates and place into Western Transfer Buffer. 

6. Cut nitrocellulose membrane to the size of the gel and briefly rinse in water, then 

place in Western Transfer Buffer (see Note 27). 

7. Cut two pieces of filter paper to the size of the gel and soak in Western Transfer 

Buffer. 

8. Assemble transfer stack according to the manufactures instructions, normally in the 

following order from the cathode, blotting pad (2), filter paper, gel, nitrocellulose 

membrane, filter paper and blotting pad (2). 

9. Place transfer stack into the Western apparatus, assemble, add Western Transfer 

Buffer and connect to electrophoretic power source. 
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10. Transfer at the recommended current for 1 hour (see Note 28). 

11. Disassemble transfer stack, remove membrane and place in TBST Buffer. 

12. Incubate membrane with gentle shaking in TBST Buffer with 5 % skim milk powder 

for 1 hour at room temperature. 

13. Dilute primary antibody in TBST Buffer with 1 % skim milk powder (see Note 29). 

14. Incubate membrane with primary antibody diluted in TBST Buffer with 1 % skim 

milk powder with gentle shaking at room temperature for 1 hour (see Note 30). 

15. Wash membrane with TBST Buffer for 10 min with shaking. Repeat wash in TBST 

Buffer two more times. 

16. Dilute HRP conjugated secondary antibody in TBST Buffer with 1 % skim milk 

powder (usually around 10,000 fold dilution) and incubate with washed membrane 

with gentle shaking at room temperature for 1 hour (see Note 31). 

17. Wash membrane with TBST Buffer for 10 min with shaking. Repeat wash in TBST 

Buffer two more times. 

18. Prepare the HRP substrate (about 1 mL) by mixing the two reagents (see Note 32). 

19. Drain excess liquid from the membrane and add HRP substrate and incubate for 1 

minute. 

20. Image using a chemiluminescence imager. 

 

3.4. Determining optimal peptides for quantification by MRM 

1. Resuspend 50 µg of microsomal protein in about 100 µL Digestion Buffer. 

2. Add DTT to the diluted protein extract to a final concentration of 25 mM and incubate 

30 min (room temperature). 

3. Add IAA to a final concentration of 50 mM and incubate 30 min (room temperature) 

in the dark. 

4. Add trypsin at a 1:10 trypsin:protein ratio (see Note 33) and incubate overnight 

(37°C) (see Note 34). 

5. Remove urea and concentrate samples with a Micro SpinColumn (25 to 75 µL 

capacity). Initially hydrate the C18 matrix with ultrapure water (75 µL) for 10 min and 

centrifuge (1000 x g, 2 min) as per manufacturer’s instructions. 

6. Wash the SpinColumn with the 50 µL SPE Buffer 1 and centrifuge (1000 x g, 2 min) 

and prime twice with 50 µL SPE Buffer 2, centrifuging (1000 x g, 2 min) after each 

step. 
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7. Add digested peptides in urea solution to the SpinColumn and centrifuge (1000 x g, 2 

min), wash twice with 50 µL SPE Buffer 2, centrifuging (1000 x g, 2 min) after each 

step. 

8. Finally elute into a new tube with 25 to 50 µL SPE Buffer 1 by centrifuging 1000 x g 

for 2 min. Concentrate and remove acetonitrile with a SpeedVac concentrator until 1 

to 5 µL of peptide solution remains in the tube. 

9. Analyse about 1 µg (approximately 0.1 µL) of the trypsin digested microsomal 

preparation by nanoflow liquid chromatography tandem mass spectrometry (LC-

MS/MS) using an automated data dependent acquisition method optimized for the 

analysis of complex protein samples (see Note 35) (Fig. 1B). 

10. Data produced after LC-MS/MS analysis can be interrogated with search algorithms, 

such as the software package Mascot (Matrix Science), to identify peptides from the 

induced membrane protein within the microsomal fraction suitable for MRM (see 

Note 36).  

11. Select unique peptides specific for the expressed protein based on precursor 

(optimally 500 to 700 m/z), charge state (optimally [M+ 2H]+2) and peptide match 

score, as it provides an indication of a MS compatibility factor. 

12. Obtain synthesize selected peptides (2 to 3) from a commercial supplier specific for 

the induced membrane protein to use as standards for MRM. 

 

3.5. Estimating abundance of induced membrane protein by MRM 

 

3.5.1 Develop the MRM method and assess standard peptides 

1. Dilute synthesized peptides standards to around 1 pmol / µL with Infusion Buffer. 

Then using the syringe pump and the Hamilton syringe, infuse the mixture into the 

triple quadrupole mass spectrometer at about 50 µL / min (or a similar flow rate to be 

used for MRM analysis) and monitor peptide using a Q1 scan mode (see Note 37). 

2. Optimize conditions for the peptides, for example deculstering potential, gas flow 

rate, gas temperature (see Note 38) to maximize their signal-to-noise ratio. 

3. Optimize the fragmentation conditions for each peptide in turn using Product Ion 

mode (MS2) or equivalent. Take note of the value used for the collision energy (CE) 

that resulted in the absence of the precursor ion (peptide) and also produced product 
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ions with optimal signal-to-noise ratio. Take note of 2 or 3 product ions corresponding 

to valid y- or b-series ions for each peptide. 

4. Create MRM method using the experimentally optimized values for each transition 

including Q1 mass (precursor ion), Q3 masses for each precursor ion (product ions), 

Collision Energy (CE) and a time (msec) for each transition (see Note 39) (Fig. 2). 

5. Create a simple LC elution method (30 to 50 min) with a 10 to 20 min acetonitrile 

gradient (2 % acetonitrile to 80 % acetonitrile). 

6. Dilute synthesized peptides in MS Buffer A, load about 5 pmol and analyse using the 

MRM and LC methods outlined above. 

7. View and assess the subsequent results using the MS software provided with the mass 

spectrometer, making note of the elution window for each peptide, elution times, and 

signal intensities for different transitions (product ions) from the same peptide. At this 

stage, transitions (product ions) resulting in poor signals could be eliminated from the 

method (retain at least two), peptides could be eliminated if they are not retained on 

the column, elute as a split peak or elution occurs over a wide window (see Note 40). 

8. Add the peptide sequences to the Skyline software package, then select the precursor 

mass using “pick children” with the corresponding charge state as observed in the 

mass spectrometer (e.g. ++ or +++ or ++++). Select the product ions using the “pick 

children” option for the appropriate charge state empirically determined and analysed 

above (e.g. y6, b3). Save the target list as a Skyline file (Fig. 3A). 

9. Import the raw MS data file from the 5 pmol standard peptide analysis into Skyline 

and check to ensure that all peptides and transitions have imported correctly by 

selecting each peptide and transition and comparing them to the results observed on 

the MS software provided with the mass spectrometer (Fig. 3B). 

 

3.5.2 Absolute quantification of the induced protein in microsomal membrane fraction 

1. Utilize approximately 10 µg (1 µL) of the trypsin digested microsomal preparation 

(see Section 3.4) in MS Buffer A and analyse using the method which was developed 

and validated with the standard peptides (see section 3.5.1). 

2. View and assess the results using the MS software provided with the mass 

spectrometer. Check the elution times and the signal intensities for different 

transitions and compare to the results from the 5 pmol peptide standard analysis.  
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3. If the peptides are clearly detectable in the microsomal preparation, a rough 

estimation of induced protein content can be made by comparing the intensity from 

the 5 pmol standard sample to the microsomal sample. 

4. Based on comparisons between the signals from the 5 pmol standard peptide and the 

10 µg microsomal preparation, estimate a range of concentrations required to generate 

a standard curve from the peptide standards. Based on numerous examples, we have 

found the following standard curve seems to cover most variations in expression when 

conducting MRM analysis at flow rates around 400 µL / min: 0.1 pmol, 0.25 pmol, 

0.5 fmol, 1 pmol, 5 pmol, 20 pmol. 

5. Create a sample sequence with the MRM method that analyses the range of 

concentrations for the standard curve (step 4 above), with the digested 10 µg 

microsomal preparation interspersed in the sequence (Fig. 1C). The objective is to 

generate a minimum of three replicates for each concentration of the standard peptide 

solution and a similar number for the microsomal preparation (10 µg each). 

6. Open the previously saved peptide target list in Skyline and import the raw MS data 

files for the replicates of the microsomal preparation and the standard curve (Fig. 3C). 

7. Inspect each peptide from these samples to ensure that the correct peaks have been 

assigned. Compare the retention time to that of the synthetic standard peptides. The 

correct peak can be manually selected in Skyline using the mouse. The retention times 

for all samples and all peptides can be easily checked using View > Retention Times 

> Replicate Comparison option. Also check that each fragment transition is present 

and that each one has a similar proportion as the fragment transitions found for the 

synthetic standard peptides. 

8. Export the results (File > Export > Report) as a .csv (a report) file with data 

corresponding to precursor ‘Total Area’ (see Note 41). 

9. Open exported data in Microsoft Excel (or similar) and generate a standard curve 

using data from the synthetic standard peptides e.g. amount loaded (pmol) against the 

precursor ‘Total Area’ values for each peptide. 

10. Using the standard curve and the ‘Total Area’ values, estimate the average amount 

(pmol) of peptide in the microsomal fractions. This value corresponds to the number 

of moles of the expressed membrane protein. Estimate the amount (g) of protein in the 

total analysed microsomal fraction (10 µg) using the calculated molecular weight of 
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the expressed fusion protein. Then estimate the percentage of expressed protein in the 

microsomal fraction (see Note 42). 

11. Estimate the amount of expressed protein used in the assay and in combination with 

the previously determined value for Vmax to calculate kcat. 
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4. Notes 

1. The yeast strain, INVSc1, (Thermo Fisher Scientific) is a fast-growing strain and ideal 

for protein expression. INVSc1 genotype: MATa his3D1 leu2 trp1-289 ura3-52 MAT 

his3D1 leu2 trp1-289 ura3-52 

2. Any suitable yeast expression vector should suffice. The pYES-DEST52 expression 

vector is galactose inducible with a uracil (URA3) selectable marker for yeast growth 

and with a C-terminal V5 epitope and 6xHis tags. The vector is also a Gateway 

destination vector with antibiotic resistance (ampicillin) for initial cloning in 

Escherichia coli. We have used this vector successfully to express over 50 plant, 

fungi and mammalian membrane proteins in yeast. 

3. Transformation of yeast can be readily undertaken without a commercial kit, however 

these systems are a cost effective and efficient means to accomplish a successful 

transformation, especially if being undertaken for the first time. 

4. Contains nitrogen source, vitamins, trace elements and salts for optimal yeast growth 

and is used in conjunction with the yeast drop-out media. The ratio required for yeast 

media will depend on the supplier. 

5. Contains amino acids and other nutrients (e.g. adenine, inositol and etc.) absent from 

the Yeast Nitrogen Base. The pYES-DEST52 vector contains the auxotrophic 

selection marker URA3 (orotidine 5'-phosphate decarboxylase) which converts 

orotidine monophosphate (OMP) to uridine monophosphate (UMP). Depending on 

the yeast expression vector, the appropriate drop-out media is required. 

6. Baffled flasks create a turbulent flow and increase gas exchange at the surface of the 

liquid to increase oxygen intake. 

7. The pYES-DEST52 vector contains the promoter sequence of the GAL1 gene 

upstream of the attR region for induction of the gene of interest. The appropriate 

induction method is dependent on the yeast expression vector utilized. 

8. The addition of sodium azide (often referred to as STOP buffer) will inhibit further 

activity and arrest metabolism. Take adequate precautions as sodium azide is a potent 

inhibitor of mitochondrial respiration. 

9. The type of buffer and volume used will greatly depend on the downstream enzyme 

assay that will be conducted. 
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10. A 12 % polyacrylamide gel is a good compromise for the generic separation of 

proteins. If purchasing precast polyacrylamide gels, consider a gradient gel employing 

8 to 16 % acrylamide. 

11. The selection of the primary antibody will be determined by the protein tag (if any) in 

the expression vector. 

12. The type of secondary antibody will depend on the origin of the primary antibody, but 

is commonly either Anti-Mouse (usually monoclonal antibodies) or Anti-Rabbit 

(usually polyclonal antibodies). 

13. In recent times, access to tandem mass spectrometers has become relatively cost-

effective with a variety of service-based facilities at many institutions. 

14. Urea can be unstable and degrade in solution when exposed to elevated temperatures 

(> 25°C) or over time. Degradation products such as isocyanic acid can react with the 

amino terminus of proteins and sidechains of lysine and arginine residues. 

Consequently, it is recommended that urea solutions be made fresh as required. 

15. A stock solution of DTT can be stored in aliquots at -20°C. 

16. A stock solution of IAA can be stored in aliquots at -20°C. IAA is used to alkylate 

thiol group on cysteine residues after reduction with DTT. It is virtually impossible to 

detect cysteine containing peptides unless controlled alkylation is undertaken. IAA is 

light and heat sensitive and should be stored in the dark. 

17. Tandem mass spectrometers designed for proteomic workflows will usually ship with 

software for the interrogation of tandem spectra for the identification of proteins and 

it is likely that any MS service facility will have a variety of packages. However there 

are a number of open source software packages available as well as a range of third 

party products that can be accessed online. The algorithms are generally similar in 

their approach, although we use Mascot (a third party software package from Matrix 

Science) as it provides quality results when high confidence cut-offs are employed. 

Access to the software is free if submitting less than 1200 spectra in a single 

submission (http://www.matrixscience.com/). 

18. The selection of the synthetic peptides to use as standards for MRM-based 

quantitation will depend on a number of factors after inspecting the results from the 

LC-MS/MS analysis of the microsomal fraction. If a yeast expression vector with a 

protein tag has been employed, e.g. the V5 epitope, it is often cost-effective to select a 

tryptic peptide from this region that can be used in future experiments with different 

http://www.matrixscience.com/


17 

proteins. If no tag was employed or if no suitable tag derived peptides were identified 

after shotgun analysis of the microsomal fraction, select protein specific tryptic 

peptides. The objective is to select MS-compatible tryptic peptides with no 

miscleavage and no modifications (avoid methionine and cysteine containing 

peptides). Optimally, 2 to 3 doubly charged [M+2H]2+ peptides in the range of 500 to 

700 m/z appear to produce optimal results with regard to signal and fragmentation . If 

no peptides were identified after shotgun analysis of the microsomal fraction, first 

ensure adequate expression and if necessary optimize protein expression. If there are 

still no candidates, there are a number of utilities that can predict peptides suitable for 

MRM from the amino acid sequence, such as, the Arabidopsis Proteotypic Predictor 

[13]. 

19. The Skyline software package is a freely-available, open-source application for 

developing MRM methods and analysing the resultant data. The software can be used 

to select candidate peptides and fragment ions for an MRM experiment from a protein 

sequence. It can also be used to optimise the declustering potential and collision 

energy for a set of peptides. The Skyline website has an extensive collection of 

tutorials and help pages. 

20. In parallel, ensure that an empty vector control is also transformed and resultant 

microsomes are employed throughout the entire assay. 

21. While there are numerous protocols for yeast transformation, we have found that 

using a commercial kit is cost and time effective. 

22. The pYES-DEST52 vector harbours a galactose inducible promoter for induction of 

the transgene. This step will be dependent on the expression vector being employed. 

23. If there are difficulties obtaining a stably expressed protein, check expression by 

immunoblotting at earlier time points, such as after 6 hours. 

24. Depending on the source and batch of Lyticase, the appropriate proportion to add to 

the solution, based on mg fresh weight of yeast, will need to be calculated. 

25. The use of 37 °C is optimal for digestion of yeast cell walls, however the expressed 

protein may be heat sensitive. Consequently, this step may require assessment 

depending on protein expression levels. A lower temperature for a longer incubation 

period can be used. 
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26. Using a precast gel system is the simplest and most convenient way to analyse 

multiple fractions. Assemble the apparatus with the precast gel and compatible buffers 

following the manufacturer’s instructions. 

27. Ensure that the methanol has been added to commercially sourced transfer buffers. 

28. A range of conditions can be used including overnight transfers, however voltage 

adjustments are required. Check the instructions of the specific transfer apparatus for 

advice on specific conditions. 

29. The dilution of a primary antibody will vary depending on its specificity. A range will 

be provided by the supplier; however some testing may be required to obtain an 

optimal signal. A dilution range between 500 and 5000 is common for polyclonal 

antibodies. 

30. To minimize the amount of primary antibody employed, only make enough of this 

solution so as to cover the membrane and employ a small container. 

31. A variety of conjugations are available for the detection of secondary antibodies, 

however HRP (horse radish peroxidase) is one of the most common as it is a robust 

enzyme that enables detection by a variety of techniques. 

32. When mixed, the HRP substrate is light sensitive. Therefore keep away from light 

(wrapped) and use immediately. 

33. The recommended ratio of trypsin to protein (w/w) is generally 1:20 or 1:50. However 

this will depend on the type of trypsin being employed. If using modified trypsin (not 

subject to autolysis), then the recommended ratios can be used, however if 

unmodified trypsin is used, we recommend using it at higher ratios. The advantage of 

unmodified trypsin, is that autolytic products (peptides) can act as internal controls for 

sample handling and mass spectrometry. 

34. An overnight digestion is likely excessive, however the timing usually suits the 

standard sample processing workflow. 

35. The analysis of 1 µg of a complex peptide lysate by nano-LC-MS/MS should result in 

the high-confidence identification of between 1000 and 2000 proteins for species with 

well curated genomes. In this instance, up to 1000 yeast proteins are likely to be 

detected using this approach. 

36. To ensure that only high-confidence proteins and peptides are identified from the 

fragmentation spectra, employ recommended protein and peptide cut-offs to ensure 

spectral match probabilities are < 0.05 or false discovery rates are < 1 %. If using 
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Mascot, an ions score value is provided for peptide matches and needs to be entered 

manually in the “Ions score or expect cut-off” box. Using such an approach, only 

high-confidence peptides matches are used to define the resultant identified proteins. 

This means that even proteins identified by a single peptide can be regarded as high- 

confidence matches, although a replicate experiment will be required to independently 

identify and confirm its existence in the sample. 

37. As indicated above, the Skyline software package can be used to create the MRM 

method and to optimize collision energy and fragment ions (File > Export > Method) 

after entering peptide information into the software. 

38. Check that you have selected the most abundant charge state for the peptide, often 

peptides > 1,600 Da will be found in two charge states [M+2H]+2 and/or [M+3H]+3. 

39. Newer instruments can employ quite short dwell times to monitor hundreds of MRM 

transitions, however given that only a handful of peptides will be analysed, dwell 

times of 50 to 100 msec can be readily employed. 

40. The peptide elution window will depend on a number of factors. Using a traditional 

setup employing nanoflow or capflow LC delivery rates, peaks widths of 1 to 2 

minute would be expected. However, it is now more common to conduct MRM-type 

analyses using Ultra Performance Liquid Chromatography (UPLC) and depending on 

the flowrate employed, peptide elution windows can be less than 10 seconds. 

41. Skyline has a collection of report templates, however none provide ‘Total Area’ i.e. 

the area of all transitions of a given peptide. Simply edit a report template e.g. Peptide 

RT Results, and add ‘Total Area’ to the report. The ‘Total Area’ option is found under 

Proteins > Precursors > Precursor Results. 

42. For proteins exhibiting good expression in yeast, after MRM quantitation, we have 

calculated that the expressed protein comprises around 1 % of total microsomal 

protein. 
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Figure Captions 

 

Fig. 1. Workflow outlining the basic procedure for quantification of expressed 

membrane proteins in yeast. 

(A) Immunoblot analysing the expression of an induced membrane protein in yeast 

microsomal fractions using the Anti-V5-tag antibody (see Section 3.3) 

(B) Shotgun LC-MS/MS analysis of yeast microsomal preparations containing the induced 

membrane protein to identify unique peptides for MRM (see Section 3.4). 

(C) Analysis of yeast microsomal preparations containing the induced membrane protein 

using MRM with a triple quadrupole mass spectrometer (see Section 2.5.2). 

 

Fig. 2. Basic parameters to be included in the MS method necessary to conduct MRM 

analyses. 

The ‘Q1 Mass’ corresponds to the observed m/z of the peptide. The ‘Q3 Mass’ represents the 

m/z of dominant product ions. The ‘Time’ represents the time spent collecting data on each 

transition. The ‘CE’ indicates the collision energy. Both the dominant product ions and the 

collision energy can be obtained empirically by initially infusing the synthesized peptide. 

 

Fig. 3. Overview of the main features of Skyline. 

(A) An example peptide entry in Skyline with the charge state for the peptide selected (++) 

and the three dominant product ions [y10], [y9] and [y5] shown. The green circles indicate 

that all three transitions were detected in the sample. 

(B) MRM raw data for a synthesized peptide (FYLPDIFPGLNK) imported into Skyline. 

Note the differences in transition intensity, with [y9] and [y5] producing more intense signals 

under these condition compared to the [y10] fragment ion. 

(C) MRM data from a complex lysate with a protein containing the tryptic peptide 

(FYLPDIFPGLNK). Data from complex biological samples result in background and 

reduced signal. Note that the retention time matches the one of the standard peptide and the 

profile of transitions also corresponds, albeit the signal for the [y10] fragment ion is low. 
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